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1 GENERAL INFORMATION
1.1 Contact Data

Support

If you cannot find information you need in this guide, or if you have questions or problems, contact
Brainlab support:

Region Telephone and Fax Email

United States, Canada, Central
and South America

Tel: +1 800 597 5911
Fax: +1 708 409 1619

us.support@brainlab.com

Brazil Tel: (0800) 892 1217 brazil.support@brainlab.com

UK Tel: +44 1223 755 333

support@brainlab.com

Spain Tel: +34 900 649 115

France and French-speaking
regions Tel: +33 800 676 030

Africa, Asia, Australia, Europe
Tel: +49 89 991568 1044
Fax: +49 89 991568 811

Japan
Tel: +81 3 3769 6900
Fax: +81 3 3769 6901

Expected Service Life

Brainlab provides eight years of service for software. During this period of time, software updates
as well as field support are offered.

Feedback

Despite careful review, this user guide may contain errors. Please contact us at
user.guides@brainlab.com if you have improvement suggestions.

Manufacturer

Brainlab AG
Olof-Palme-Str. 9
81829 Munich
Germany

GENERAL INFORMATION
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1.2 Legal Information

Copyright

This guide contains proprietary information protected by copyright. No part of this guide may be
reproduced or translated without express written permission of Brainlab.

Brainlab Trademarks

Brainlab® is a trademark of Brainlab AG.

Non-Brainlab Trademarks

Microsoft® and Windows® are registered trademarks of Microsoft Corporation in the US and other
countries.

Patent Information

This product may be covered by one or more patents or pending patent applications. For details,
see: www.brainlab.com/patent.

Integrated Third-Party Software

This software is based in part on the following work. The full license and copyright notice can be
found at the links below:
• Independent JPEG Group (https://github.com/uclouvain/openjpeg/blob/master/LICENSE)
• OpenJPEG (https://github.com/uclouvain/openjpeg/blob/master/LICENSE)
• libjpeg-turbo (https://github.com/libjpeg-turbo/libjpeg-turbo/blob/master/LICENSE.md)
• libtiff 4.0.4 beta (http://www.libtiff.org/misc.html)
• Xerces-C++, developed by the Apache Software Foundation (http://xerces.apache.org/xerces-

c/)

CE Label

The CE label indicates that the Brainlab product complies with the essential re-
quirements of Council Directive 93/42/EEC (the “MDD”).
Spine & Trauma 3D Navigation is a part of the Spine & Trauma Navigation
System, which is a Class IIb product according to the rules established by the
MDD.

Sales in US

US federal law restricts this device to sale by or on the order of a physician.

Report Incidents Related to This Product

You are required to report any serious incident that may have occurred related to this product to
Brainlab, and if within Europe, to your corresponding national competent authority for medical
devices.

Legal Information
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1.3 Symbols

Warnings

Warning
Warnings are indicated by triangular warning symbols. They contain safety-critical
information regarding possible injury, death or other serious consequences associated
with device use or misuse.

Cautions

Cautions are indicated by circular caution symbols. They contain important information
regarding potential device malfunctions, device failure, damage to device or damage to
property.

Notes

NOTE: Notes are formatted in italic type and indicate additional useful hints. 

Product Symbols

Symbol Explanation

Manufacturer

Consult instructions for use

Unique Device Identifier

Medical Device

U.S. federal law restricts this device to sale by or on order of a physician
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1.4 Using the System

Intended Use and Indications for Use/Intended Purpose

The Spine & Trauma Navigation System is intended as an intraoperative image-guided
localization system to enable minimally invasive surgery. It links a freehand probe, tracked by a
passive marker sensor system to virtual computer image space on a patient's preoperative or
intraoperative 3D image data.
The Spine & Trauma Navigation System enables computer-assisted navigation of medical
image data, which can either be acquired preoperatively or intraoperatively by an appropriate
image acquisition system. The software offers screw implant size planning and navigation on rigid
bone structures with precalibrated and additional individually-calibrated surgical tools.
The system is indicated for any medical condition in which the use of stereotactic surgery may be
appropriate and where a reference to a rigid anatomical structure, such as the skull, the pelvis, a
long bone or vertebra can be identified relative to the acquired image (CT, MR, 2D fluoroscopic
image and 3D fluoroscopic image reconstruction) and/or an image data based model of the
anatomy.

Known Contraindications

There are no known contraindications for the use of this device.

Place of Use

The planning tasks shall be performed in an office or in the operating room.
The navigation tasks shall be performed in an operating room/suite.

User Profiles

Neuro / Ortho / Spine / Trauma surgeons or their assistants having a 3D image acquisition system
(such as CT or 3D C-arm), or utilizing preoperatively acquired CT / CT like (and potentially fused
MR) imaging data in combination with a Brainlab navigation system.

Patient Population

The patient population includes any medical condition in which the use of stereotactic surgery
may be appropriate and where a reference to a rigid anatomical structure, such as the skull, the
pelvis, a long bone or vertebra can be identified relative to the acquired image (CT, 3D
fluoroscopic image reconstruction).

Clinical Benefit

The Spine & Trauma Navigation System provides the following benefits:
• Higher accuracy in placement of screw implants in comparison to conventional techniques
• Reduced radiation dose for the operating staff in comparison to conventional techniques
• Lower (intra-operative and post-operative) complication rate due to misplaced screws in

comparison to conventional techniques
• The need for the patient to return to the operating room for revision surgery is reduced or

eliminated

Careful Handling of Hardware

System components and accessory instrumentation are comprised of precise mechanical
parts. Handle them carefully.

Using the System
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Plausibility Review

Warning
Before patient treatment, review the plausibility of all information input to and output from
the system.

GENERAL INFORMATION
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1.5 Compatibility with Medical Devices and Software

Compatible Brainlab Instruments

• Accessory Package Spine for Anterior/Lateral/Oblique Referencing
• Accessory Package Spine for Open Surgery (Awls & Probes)
• Adhesive Flat Markers
• Auto-Registration Hardware Fluoro 2D / 3D for 3D C-arms
• Bone Fixator 1-Pin X-Press, Size S, M, L
• Bone Fixator 2-Pin X-Press
• Calibration Phantom CT Scanner
• Chisel Long
• Chisel Short
• Disposable Reflective Marker Spheres
• DrapeLink Reference Unit for C-arm Left, Right
• Drill Bits with AO Shank
• Drill Guide Handle with 3 Marker Spheres
• Drill Guide Handle with 4 Marker Spheres
• Drill Guide Compact Handle with 4 Marker Spheres
• Drill Guide Tubes
• Instrument Adapter Package
• Instrument Adapter for Surgical Motor System
• Instrument Calibration Matrix
• Instrument Reference Unit for Manual Calibration Size ML, L
• Instrument Reference Unit with 3 Marker Spheres
• Instrument Reference Unit with 4 Marker Spheres
• Microscope Tracking Array
• Pedicle Access Needle Set for Manual Calibration
• Pointer Extended with Sharp Tip for Spine / Trauma / Hip
• Reference Array for Spine Clamps with 4 Marker Spheres
• Reference Array Quick Fastener X-Press
• Reference Array Y-Geometry X-Press
• Reflective Disks for Fluoro Registration Kit
• Skull Reference Array
• Spine Reference Array for Reference Clamp Carbon (4-Sphere Geometry)
• Spine Reference Clamp Carbon with Slider
• Spine Reference X-Clamp Extension 40mm
• Spine Reference X-Clamp Size S, L
• Spine Reference Clamp Radiolucent
• Standard Cranial Reference Array with 4 Marker Spheres

Other Brainlab Instruments

Additional instrumentation may become available after release of this user guide. Contact Brainlab
support if you have any questions regarding compatibility.

Warning
Only use instruments and spare parts specified by Brainlab. Using unauthorized
instruments/spare parts may adversely affect safety and/or effectiveness of the medical
device and endanger the safety of the patient, user and/or environment.

Compatibility with Medical Devices and Software
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Instrument Assembly

If any instrumentation is used with this product, ensure that all instruments are correctly
assembled according to the instructions within the corresponding Instrument User Guide.

Non-Brainlab Devices

Warning
Using medical device combinations that have not been authorized by Brainlab may
adversely affect safety and/or effectiveness of the devices and endanger the safety of the
patient, user and/or environment.

Not for Use with Stereo Monitors

Spine & Trauma 3D Navigation is not intended to be used with stereo (3D) monitors.

Compatible Brainlab Medical Software

Only Brainlab medical software specified by Brainlab may be installed and used with the system.
Contact Brainlab support for clarification regarding compatibility with Brainlab medical software.

Non-Brainlab Software

Only authorized Brainlab employees may install software on the Brainlab system. Do not
install or remove any software applications.

Updates

Warning
Updates to the operating system (hotfixes) or third-party software should be performed
outside clinical hours and in a test environment to verify correct operation of the Brainlab
system. Brainlab monitors the released Windows hotfixes and will know, for some updates,
if problems can be expected. Contact Brainlab support if any problems to operating system
hotfixes are encountered.

Virus Scanning and Malware

Brainlab recommends protecting the system with state-of-the-art anti-virus software.
Be aware that some malware protection software (e.g., virus scanner) settings can negatively
affect system performance. For example, if real-time scans are performed and each file access is
monitored, then loading and saving patient data may be slow. Brainlab recommends disabling
real-time scans and performing virus scans during non-clinical hours.

Warning
Ensure that your anti-virus software does not modify any Brainlab directories, specifically:
• C:\Brainlab, D:\Brainlab, F:\Brainlab, etc.
• C:\PatientData, D:\PatientData, F:\PatientData, etc.

Warning
Do not download or install updates during treatment planning.
Contact Brainlab support for further information regarding any of these issues.

GENERAL INFORMATION
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Microsoft Security Updates for Windows and Driver Updates

Brainlab allows the installation of security patches only. Do not install service packs and optional
updates. Verify your settings to ensure updates are downloaded and installed correctly and at a
suitable time. Do not update drivers on Brainlab platforms.
See the Brainlab website for more information about settings and a list of Microsoft Security
Updates blocked by Brainlab support.
Address: www.brainlab.com/updates
Password: WindowsUpdates!89

Compatibility with Medical Devices and Software
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1.6 Training and Documentation

Brainlab Training

Before using the system, all users must participate in a mandatory training program held by a
Brainlab authorized representative to ensure safe and appropriate use.

Supervised Support

Before using the system for surgical procedures where computer-aided navigation is considered
critical, perform a sufficient number of complete procedures together with a Brainlab
representative.

Responsibility

Warning
This system solely provides assistance to the surgeon and does not substitute or replace
the surgeon's experience and/or responsibility during its use. It must always be possible
for the user to proceed without the assistance of the system.
Only trained medical personnel may operate system components and accessory instrumentation.

Extended OR Time

Brainlab Navigation Systems are sensitive technical equipment. Depending upon OR setup,
patient positioning, calculation durations and complexity, surgery duration using navigation may
vary. It is up to the user to decide whether a potential prolongation is acceptable for the respective
patient and treatment.

Reading User Guides

This guide describes complex medical software or medical devices that must be used with care.
It is therefore important that all users of the system, instrument or software:
• Read this guide carefully before handling the equipment
• Have access to this guide at all times

GENERAL INFORMATION
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2 SPINE & TRAUMA 3D
NAVIGATION
INTRODUCTION

2.1 Getting Started

Background

Spine & Trauma 3D Navigation enables navigation of instruments using the Spine & Trauma
Navigation System.

Selecting Instruments

Instruments that were calibrated in Instrument Selection are loaded for use with Spine &
Trauma 3D Navigation.
NOTE: To return to Instrument Selection at any time during navigation, hold the Instrument
Calibration Matrix and instrument close together in the camera field of view. Alternatively, use the
Home button to manually open Instrument Selection. 

OR Setup

The reference array must be visible to the camera at all times during registration and navigation,
otherwise tracking is not possible.

Warning
Infrared artifacts caused by reflections can affect the accuracy of the optical navigation
system. Ensure that highly reflective items and sources of infrared light do not disturb the
camera field of view at any time.

SPINE & TRAUMA 3D NAVIGATION INTRODUCTION
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How to Set Up the Camera and Monitor

Figure 1  

The system setup varies depending on the system used and the type of procedure being
performed.

Step

1. Position the camera and monitor while keeping the following points in mind:
• Select a camera position that works throughout the entire procedure (including later

navigation).
• The camera and monitor must not restrict the surgeon during surgery.
• Avoid major movement of the camera during a procedure. If the camera is moved, you

must verify the accuracy again.
• The camera must have a clear view of the reference array and instruments throughout

the procedure, including all registration and navigation procedures. To provide an opti-
mum view, the camera should be approximately 1.2 - 1.8 meters (4 - 6 feet) away from
the surgical field.

2. Plug in and turn on the system.
Refer to the relevant System User Guide (e.g., Kick, Curve).

3. Start the software.

Getting Started
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Step

4. Ensure the reference array is visible to the camera.
The following view is displayed to indicate whether the array is visible to the camera.

①

If the array is not visible, adjust the camera distance and angle until the array representa-
tion ① is visible.

Camera Display

①

② ③

④

Figure 2  

Select Camera to open the array representation view.

No. Description

①
Displays the distance of the instruments and/or reference arrays in relation to the cam-
era. For optimum visibility and accuracy, all marker spheres shall be inside the blue
corridor.

② Displays the position of the instruments and/or reference arrays in relation to the cam-
era.

③ Camera motor control positioning buttons (if available).

④
Used to center the camera.
NOTE: Centering the camera takes up to five seconds. Select again to deactivate the
centering feature. 

SPINE & TRAUMA 3D NAVIGATION INTRODUCTION

Software User Guide Rev. 1.0 Spine & Trauma 3D Navigation Ver. 1.5 17



Using the Disposable Clip-on Remote Control

①

Figure 3  

The Disposable Clip-on Remote Control can be used in combination with the Pointer
Extended with Sharp Tip. Press the control button ① at various steps in the workflow to accept
planned screw position or proceed to the next step.
For more information on the Disposable Clip-on Remote Control see the Spine and Trauma
Instrument User Guide.

Getting Started
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How to Open Spine & Trauma 3D Navigation

②

①

Figure 4  

Step

1. Optional: Select a patient or add a new patient.

2. Optional: Select a disease classification.

3. Under the Spine & Trauma category, select 3D Navigation ①.

4. Under the Navigation category, select Navigation ②.
NOTE: For more information see the Patient Data Manager Software User Guide. 

SPINE & TRAUMA 3D NAVIGATION INTRODUCTION
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2.2 Toolbar

Home Button

Select Home to return to your start page. All changes are saved and Spine
& Trauma 3D Navigation remains running in the background. From the start
page you can open other Brainlab applications (e.g., Instrument Selection).

Data Menu

① ②

③

④

⑤

Figure 5  

No. Component

① Open the Data menu to select patient data and planned items.

② Select MORE to load additional patient data.

③ Select the Screws, Objects or Points tab to navigate with a previously planned screw,
object, or point.

④ Use the eye icons to show/hide specific selections within the display.

⑤ Use the trash icon to delete planned screws, objects or points.

Toolbar
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Available Layouts

Figure 6  

Within the Data menu, you can select your preferred layout.

Layout Description

Inline Two perpendicular slices of one image set. Orientation is based on instru-
ment position.

Inline + 3D/DRR/
Probe

• Two perpendicular slices of one image set. Orientation is based on instru-
ment position.

• A 3D or DRR model, the probe view or the autopilot view (depending on
your in-view selection).

Inline + DRR
• Two perpendicular slices of one image set. Orientation is based on instru-

ment position.
• Two DRR models with a default orientation difference of 45°.

Fusion
Two inline views of the two selected image sets.
NOTE: To modify the display, select an image set and then select either the
top or bottom half of the Fusion icon. 

SPINE & TRAUMA 3D NAVIGATION INTRODUCTION
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Layout Description

Spotlight DRR

• Two inline views.
• Two DRR models:

- DRR with highlighted ROI
- Axial DRR of the highlighted ROI

How to Adjust DRR ROI

①
Figure 7  

In the View menu, select Adjust DRR ROI to adjust width, angle and orientation of the ROI as
needed using the white frame ①.

Automatic Inline Detection

In the Inline views, the software automatically switches between planes, depending upon where
the instrument is placed.

Toolbar
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Zoom and View Menu

Figure 8  

Function Description

Zoom
Zoom in and out.
Use controls or a double touch to adjust zoom.

View Center Reposition the display to the center the ROI by moving the arrows on
the screen.

Flip Mode
Select Flip Mode, then use the buttons in the inline views:
• Flip: Flips the image across horizontal or vertical plane.
• Upright: Aligns the image in an upright (cranial/caudal) view.

Windowing Change the display brightness and contrast by swiping across the slice.

Reset Reset all applied modifications, except for Flip Mode.

SPINE & TRAUMA 3D NAVIGATION INTRODUCTION
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Function Description

Approach

The Approach feature allows you to select the inline view constellation.
Auto Detect is selected by default. This feature recognizes the direction
of access of the primary instrument and selects the inline view constel-
lation accordingly.
To deactivate Auto Detect and lock the inline view constellation, select
one of the following:
• Posterior/Anterior
• Lateral
• Cranial/Caudal

A lock symbol is shown in the corner of the inline views.
Deactivation can be helpful if:
• Instruments are held at an extreme angle.
• The ROI is tilted due to patient positioning or pathology.
• You experience unwanted view changes/flips.

Reactivate Auto Detect if:
• The direction of access of the primary instrument has changed during

sugery.
• The inline view constellation does not provide the expected inline sli-

ces.
• Significant modifications were made with the Orientation feature.

Orientation

Figure 9  

Orientation

Rotate/move the slices to display the preferred orientation.
• Useful if the pathology requires anatomical plane re-alignment (e.g., sco-

liosis).
• After adjustment, select Orientation again to apply the modifications and

return to the navigation view.

Reset Reset the applied modifications.

Toolbar
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Ruler

Figure 10  

Ruler

Use to estimate dimensions with the navigated instrument (toggle-on to dis-
play ruler).
• The diameter is displayed as an outline and value, and can be adjusted as

desired.
• Zoom in for a more detailed display of the ruler.

SPINE & TRAUMA 3D NAVIGATION INTRODUCTION

Software User Guide Rev. 1.0 Spine & Trauma 3D Navigation Ver. 1.5 25



2.3 Verification of Registration

Before You Begin

Before beginning navigation, registration accuracy must be verified.

Verification Tools

As needed, adjust the zoom and use the tools available in the View menu to assist in verification.

Verify Registration Accuracy: Standard Procedure

Figure 11  

Step

1. Hold the instrument on the bony surface of at least three of the following landmarks:
• Posterior (on the spinous process)/Anterior (on several locations on the lamina)
• Left/right (on the facet joint or mid-height on the spinous process)
• Cranial/caudal (on the spinous process; first on the cranial and then the caudal part)

2. Verify that the instrument position displayed on the screen matches the actual position of
the instrument on the anatomical landmark.

3. After verification, select:
• Yes if the registration is accurate, and to proceed to navigation.
• No if the registration is inaccurate, and to clear the current registration. Select either:

- Discard: Clear the previous registration.
- Discard & New: Return to the registration software to acquire a new registration.

Verify Registration Accuracy: Minimally Invasive Procedure

If you are performing a minimally invasive procedure that restricts the verification of at least three
landmarks, perform the following accuracy check:

Verification of Registration
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Step

1. Insert the instrument into the incision so it is securely touching an anatomical landmark,
reference array clamp or tooth.

2. Acquire fluoro images of the instrument on the bone:
• Lateral fluoro image (cranial/caudal or posterior/anterior registration)
• AP fluoro image (cranial/caudal or left/right registration)

3. Verify that the instrument position displayed on the screen corresponds to the position in
the fluoro image.

4. After verification, select:
• Yes if the registration is accurate, and to proceed to navigation.
• No if the registration is inaccurate, and to clear the current registration. Select either:

- Discard: Clear the previous registration.
- Discard & New: Return to the registration software to acquire a new registration.

SPINE & TRAUMA 3D NAVIGATION INTRODUCTION
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3 PLANNING AND
NAVIGATION

3.1 Screw Planning

Planning Features

The Screw Planning menu provides tools for planning screws, setting offset and fine tuning.

Screw Planning Views

①

②
Figure 12  

In some layouts, you can select the arrow button ① to change to one of the following views:
• 3D
• DRR
• DRR AP
• DRR Lateral
• Cine View (available in Fine Tuning): Plays through the slices that the screw perpendicularly

intersects. Select the button ② to pause/play through the slices as needed.
• Autopilot (available when planned screws are available)
• Probe's Eye

PLANNING AND NAVIGATION
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How to Plan Screws

Figure 13  

Step

1. Select the Screw Planning menu.
A virtual screw is added to the instrument tip.

2. Make any necessary changes to Diameter, Length or Offset (for planning screws on
skin level).

3. Select Store (or use the Disposable Clip-on Remote Control) to save the screw posi-
tion.
The screw changes from orange to blue. A new virtual screw is added to the instrument
tip.

4. Optional: Select Fine Tuning to make detailed changes to planned screws. Press in the
views to adjust the location of the screw.

5. Optional: Toggle Realistic Shape on/off to show a realistic screw shape or a simple cylin-
drical form.

6. To finish screw planning:
• Close the Screw Planning menu, or
• Select Proceed in Fine Tuning.

NOTE: If the Inline + 3D/DRR/Probe layout is selected, the Autopilot view is automati-
cally open for screw placement. 

Screw Planning
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3.2 Navigating Instruments

Background

After registration accuracy has been verified, you can begin navigation. As needed, use the
various tools available within the toolbar or Data menu to assist in navigation.

Before You Begin

Ensure that:
• Instruments are intact and do not show any signs of damage
• All instrument components are tightened (e.g., screws of the patient reference array)
• All marker spheres are within the camera field of view

Screwdriver Navigation

If you are using a screwdriver, ensure that it is always calibrated with each new screw. Hold the
Instrument Calibration Matrix and instrument close together in the camera field of view to return
to Instrument Selection for recalibration.

Flexible Instruments

Instruments with a small diameter (e.g., K-wires) have the potential to bend. The software cannot
detect bending and cannot alert you to potential inaccuries due to bending. Always use a drill
guide with instruments that may bend.

Image Fusion

If Image Fusion was used, the defined region of interest is displayed as dotted white frame. This
represents the area of rigid fusion, and therefore the region with the highest navigation accuracy
in the fused data set.

Navigation Views

• 3D
• DRR
• DRR AP
• DRR Lateral
• Probe's Eye
• Autopilot: Provides guidance for navigating the screw to the planned location.

PLANNING AND NAVIGATION
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How to Navigate Instruments

Figure 14  

Step

1. Navigate to the planned position and insert screws according to standard procedure.

2. To return to Content Manager after navigation is complete, select Done.

Ensuring Accuracy

Check regularly that the patient reference array has not moved. The software may not always
detect reference displacement.
During navigation, in particular when force is applied, visually inspect the instrument and ensure
that it is not bent or damaged.

Figure 15  

Navigating Instruments
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If reference array movement is detected, the Potential inaccuracy warning appears. It is
recommended to return to the verification page to verify accuracy.
Before beginning any surgical step (e.g., screw or implant placement), always ensure sufficient
accuracy, including the expected relative anatomical movement resulting from the applied forces.
Any movement of the reference in relation to the treated structure will have a negative effect on
navigation accuracy and may lead to an inaccurate display, creating a hazard to the patient. The
following methods can be used to ensure sufficient accuracy:
• Landmark verification
• Fluoroscopy: Compare the instrument location in the fluoro image to the representation on the

navigation system

If significant force has been applied to a bone during navigation (e.g., opening a pedicle),
always re-verify the registration accuracy.

Warning
When using the Pedicle Access Needle, ensure that the Guide Tube does not bend when
inserted into the pedicle.

PLANNING AND NAVIGATION

Software User Guide Rev. 1.0 Spine & Trauma 3D Navigation Ver. 1.5 33



Navigating Instruments

34 Software User Guide Rev. 1.0 Spine & Trauma 3D Navigation Ver. 1.5



INDEX
Numerics

3D monitors................................................................................ 11

A
accuracy..................................................................................... 32
add screws................................................................................. 29
approach.................................................................................... 23
auto detect..................................................................................23

C
camera field of view....................................................................17
camera position.......................................................................... 16

D
disposable clip-on remote control...............................................18

F
fine tuning...................................................................................30
flexible instruments.....................................................................31
flip mode.....................................................................................23

H
home button............................................................................... 20

I
Image Fusion..............................................................................31
instrument selection................................................................... 15

K
K-wires....................................................................................... 31

L
layouts........................................................................................ 21

M
monitor position.......................................................................... 16

O
offset...........................................................................................30
open software.............................................................................19
OR setup.................................................................................... 15
orientation...................................................................................24

P
plan screws................................................................................ 29
pointer........................................................................................ 18
potential inaccuracy...............................................................31,32

R
realistic shape............................................................................ 30
reference movement.................................................................. 31
registration

accuracy................................................................................. 26
tools........................................................................................ 26

registration verification............................................................... 26
minimally invasive procedure................................................. 26

ruler............................................................................................ 25

S
screw planning........................................................................... 29
screwdriver navigation................................................................31
select layouts..............................................................................21
selecting instruments..................................................................15
setup...........................................................................................15
start software..............................................................................19
stereo monitors...........................................................................11
support numbers.......................................................................... 5

V
verification.................................................................................. 26
verify accuracy........................................................................... 32
view center................................................................................. 23
visibility....................................................................................... 17

W
windowing...................................................................................23

Z
zoom...........................................................................................23

INDEX

Software User Guide Rev. 1.0 Spine & Trauma 3D Navigation Ver. 1.5 35







brainlab.com

Art-No. 60919-87EN

*60919-87EN*


	TABLE OF CONTENTS
	1 GENERAL INFORMATION
	1.1 Contact Data
	1.2 Legal Information
	1.3 Symbols
	1.4 Using the System
	1.5 Compatibility with Medical Devices and Software
	1.6 Training and Documentation

	2 SPINE & TRAUMA 3D NAVIGATION INTRODUCTION
	2.1 Getting Started
	2.2 Toolbar
	2.3 Verification of Registration

	3 PLANNING AND NAVIGATION
	3.1 Screw Planning
	3.2 Navigating Instruments

	INDEX

